Open Workbench 
1. Εισαγωγή

Είναι μια εφαρμογή που υποστηρίζει το χρονοπρογραμματισμό και τη διαχείριση έργων. Στις παραπάνω λειτουργίες περιλαμβάνεται η δημιουργία έργων, ο καθορισμός ενεργειών, η δημιουργία εξαρτήσεων μεταξύ των ενεργειών και η κατανομή των πόρων. Την απεικόνιση των παραπάνω πληροφοριών μπορεί να την πραγματοποιήσει με διάφορους τρόπους όπως με διαγράμματα Gantt, δίκτυα CPM. Επίσης το περιβάλλον αυτό επιτρέπει την ταυτόχρονη διαχείριση πολλών έργων.

2. Λογισμικό

Το λογισμικό αυτό είναι ανοιχτού κώδικα και μπορείτε να το κατεβάσετε από τη σελίδα: www.openworkbench.org/. Στη σελίδα αυτή μπορείτε να βρείτε περισσότερες πληροφορίες για το έργο. Για την εγκατάσταση του απαιτούνται:

·  wbsetup-1.0.exe (η κάποια ανώτερη έκδοση)
· Απαιτείται  η Java Runtime Engine 1.3.1 (ή κάποια μετέπειτα έκδοση).την   οποία θα βρείτε στο site http://www.java.com
3. Χαρακτηριστικά εργαλείου

Όπως αναφέρθηκε στην εισαγωγή το Workbench υποστηρίζει το σχεδιασμό και την παρακολούθηση ενός έργου. Πιο συγκεκριμένα 
Σχεδιασμός έργου 

· Διαγράμματα Gantt.

· Καθορισμός εξαρτήσεων μεταξύ των ενεργειών.

· Κατανομή πόρων.

· Προσαρμογή ημερολογίου.

· Καθορισμό ορόσημων.

Παρακολούθηση έργου.

· Καταγραφή εκτιμήσεων αναφορικά με τις ενέργειες.

· Καταγραφή πραγματικού χρόνου ενεργειών. 

· Καταγραφή ποσοστών ολοκλήρωσης ενεργειών.

4. Διαχείριση έργων

Ένα έργο είναι ένα σύνολο από συσχετιζόμενες ενέργειες οι οποίες πραγματοποιούνται για την εκπλήρωση ενός στόχου. Όλα τα έργα έχουν τρία κοινά χαρακτηριστικά:

· Έχουν ημερομηνία έναρξης και λήξης.

· Χρησιμοποιούν πόρους.

· Εμπεριέχουν το στοιχείο του ρίσκου.

Ο διαχειριστής του έργου σχεδιάζει και ελέγχει τις ενέργειες του έργου. Αυτό το άτομο οργανώνει τις ενέργειες, αναθέτει του πόρους, δίνει κίνητρα στο προσωπικό, ελέγχει την πρόοδο του έργου και φροντίζει έτσι ώστε το έργο να ολοκληρωθεί στον επιτρεπτό χρόνο και κόστος. Συνεπώς για την διαχείριση ενός έργου είναι απαραίτητη:

· Η σχεδίαση της διεργασίας.

· Η σχεδίαση του έργου.

· Ο έλεγχος του έργου.

Σχεδίαση της διεργασίας
Η σχεδίαση της διεργασίας μπορεί να πραγματοποιηθεί με τα ακόλουθα βήματα:
· Κατανόηση και εφαρμογή των αρχών της επιχείρησης αναφορικά με τη διαχείριση έργων και τη δημιουργία πλάνου έργου. Γνώση από παλαιότερα έργα μπορεί να βοηθήσει στην κατανόηση και την υλοποίηση προτύπων και οδηγιών.

· Προσδιορισμός του γενικού στόχου του έργου και των περιορισμών του (π.χ ημερομηνία λήξης η οποία πρέπει να τηρηθεί αυστηρά). Γραπτή αναφορά στην οποία δηλώνονται τα παραπάνω.

· Αναθεώρηση του ημερολογίου του έργου και άλλων παραμέτρων του έργου.

· Αρχικοποίηση του έργου με την είσοδο αρχικών τελικών ημερομηνιών.

Σχεδίαση του έργου
Η σχεδίαση του έργου γίνεται με την μέθοδο «δομής κατακερματισμού εργασιών» ανάλυσης “top-down”. Σύμφωνα με τη μέθοδο αυτή αρχικά προσδιορίζουμε τη γενική δομή του έργου και τον τρόπο με τον οποία κατανέμεται η εργασία σε διαφορετικά επίπεδα. Η δομή ενός έργου μπορεί να αποτελείται από φάσεις, δραστηριότητες ,ενέργειες και ορόσημα. 

	Επίπεδο δομής εργασίας 
	Περιγραφή

	Έργα
	Ένα σύνολο από απαραίτητες  ενέργειες για την εκπλήρωση ενός στόχου.

	Φάσεις
	Βασικές συνιστώσες των έργων.

	Δραστηριότητες 
	Βασικές συνιστώσες των φάσεων.

	Ενέργειες 
	Η μικρότερη ενότητα εργασίας που μπορεί να οδηγήσει σε κάποιο παραδοτέο.

	Ορόσημο
	Συγκεκριμένα χρονικά σημεία στα οποία γίνεται έλεγχος για την πρόοδο του έργου.


Η σχεδίαση του έργου στο Workbench περιλαμβάνει τα ακόλουθα βήματα:

· Καθορισμός της δομής του έργου.
· Προσδιορισμός των ενεργειών. 

· Δημιουργία δικτύου εξαρτήσεων.
· Προσδιορισμός πόρων.
· Εκτίμηση διάρκειας ενεργειών και χρήσης πόρων.
· Δημιουργία πλάνου.
· Προγραμματισμός πόρων.

· Αναθεώρηση πλάνου.

· Τήρηση και παρακολούθηση πλάνου.
5. Βασικό παράθυρο στο Workbench 
H βασική όψη του Workbench αποτελείται από διάφορα παράθυρα τα οποία φαίνονται στην ακόλουθη εικόνα:
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Τα διάφορα στοιχεία που εμφανίζονται στο παράθυρο του Workbench περιγράφονται στον ακόλουθο πίνακα .

	View Shortcut bar

(Μπάρα συντόμευσης )
	Εύκολη πρόσβαση σε ομάδες λειτουργιών.



	Tab Views

(Επιλογή όψης)
	Γρήγορη πρόσβαση σε διάφορα έργα. 

	Task detail

(Λεπτομέρειες ενεργειών)
	Εμφάνιση πλάνου έργου. 

	Resource detail (Λεπτομέρειες πόρων)
	Εμφανίζει λεπτομέρειες αναφορικά με τους πόρους που είναι διαθέσιμοι για χρήση. 

	Gantt chart
(Διάγραμμα Gantt)
	Εμφανίζει την κατάσταση των ενεργειών, τις αρχικές και τελικές του ημερομηνίες και την διάρκειά τους.

	Split bar 
(Μπάρα διαχωρισμού)
	Χωρίζει το παράθυρο σε τμήματα, μετακινείται με το κλασσικό τρόπο (drag). 

	Panes

(Τμήματα)
	Ανάλογα με την επιλογή λειτουργίας το παράθυρο χωρίζεται σε διάφορα τμήματα. 

	Toolbar buttons 

(Κουμπιά μπάρας εργαλείων)
	Γρήγορη πρόσβαση σε κάποιες λειτουργίες.

	Header buttons(Κουμπιά επικεφαλίδας)
	Επιλογή γραμμής. Διπλό κλικ σε αυτήν και ανάλογα με τμήμα εμφανίζονται οι ιδιότητες τμήματος.


Καθορισμός ιδιοτήτων έργου.

Για να καθορίσουμε τις ιδιότητες ενός νέου έργου ακολουθούμε τα ακόλουθα βήματα:

· Ανοίγούμε ένα νέο ή υπάρχον έργο.

· Από το μενού File → Properties (ή με διπλό κλικ στην επικεφαλίδα του έργου) καθορίζουμε τις ιδιότητές του.

· Η δημιουργία ή η  αλλαγή των ιδιοτήτων ενός έργου αφορά τα ακόλουθα στοιχεία: 

	Tab Name
	Use

	Description

(Περιγραφή)
	Διαχειριστικές λεπτομέρειες του έργου.

	Scheduling
(Προγραμματισμός)
	Δημιουργία ή τροποποίηση ιδιοτήτων έργου.

	Resources
(Πόροι)
	Επιλογή πόρων από τους διαθέσιμους.

	Key Tasks
(Βασικές ενέργειες)
	Προβολή βασικών ενεργειών .

	Adnanced
(Προχωρημένα) 
	Εισαγωγή προχωρημένης πληροφορίας που αφορά τη διαχείριση του έργου.

	Notes
(Σημειώσεις)
	Πληροφορίες που αφορούν το έργο.


Description tab 
Περιλαμβάνει:
Name: Καθορισμός ονόματος έργου
ID: Κωδικός έργου
Department: Τμήμα ανάπτυξης έργου
Budget: Προϋπολογισμός
Description: Περιγραφή 

Για να εισάγετε ένα νέο έργο πρέπει τουλάχιστον να βάλετε τον κωδικό του. 
Scheduling tab
Περιλαμβάνει:

Start:Ημερομηνία έναρξης
Impose: Απαραίτητη επιλογή για την χρήση της εντολής Autoschedule με τη περιορισμό την ημερομηνία έναρξης
End: Ημερομηνία λήξης
Impose: Απαραίτητη επιλογή για την χρήση της εντολής Autoschedule με τη περιορισμό την ημερομηνία λήξης
As-of-date: Ημερομηνία η οποία είναι σημείο αναφοράς και διαχωρίζει τα πραγματικά δεδομένα από τα μελλοντικά δεδομένα
Priority: Η  προτεραιότητα καθορίζει την σειρά με την οποία οι ενέργειες προγραμματίζονται από την εντολή Autoschedule με βάση τους περιορισμούς εξαρτήσεων. Η προτεραιότητα παίρνει τιμές απο 0 εως 36 με default τιμή 10.  (0 =υψηλή προτεραιότητα 36 =χαμηλή προτεραιότητα)
Critical path type: οι υπολογισμοί της μεθόδου CPM μπορούν να βασιστούν είτε στις τρέχουσες ημερομηνίες, είτε στις ημερομηνίες που είχαμε θέσει αρχικά στο πλάνο.
Select the Subnets: Η μέθοδος CPM μπορεί να υπολογίσει όλα τα κρίσιμα μονοπάτια που αφορούν όλα τα υποδίκτυα των ενεργειών ή να υπολογίσει ένα μόνο κρίσιμο μονοπάτι που αφορά όλες τις ενέργειες.
Resources tab
Οι πόροι είναι τα αναγκαία άτομα που συμμετέχουν στο έργο ώστε να ολοκληρωθεί στην ώρα του. Αρχικά πρέπει να οριστούν οι πόροι του έργου στο κατάλληλο τμήμα των πόρων έτσι ώστε στη συνέχεια οι πόροι αυτοί να είναι ορατοί στο έργο.  Με το Add προσθέτουμε ένα πόρο σε ένα έργο.
Key tasks tab
Στο σημείο αυτό φαίνονται οι βασικές ενέργειες ενός έργου, αν έχουν οριστεί κάποιες. Επίσης μπορεί να καταργηθεί ο χαρακτηρισμός μιας ενέργειας ως σημαντική αν χρησιμοποιηθεί η εντολή Remove.
Advanced tab
Στο παράθυρο αυτό μπορεί να γίνει εισαγωγή κάποιων ιδιοτήτων του έργου. Ανάλογα με τις επιλογές που έχουν γίνει σε προηγούμενα βήματα κάποια από αυτά τα πεδία παραμένουν σταθερά (οι τιμές τους δεν αλλάζουν). Οι εισαγωγή δεδομένων στα πεδία αυτά μπορεί να γίνει με 4 τρόπους:

· Με τα check box

· Με την εισαγωγή αριθμητικών τιμών η ημερομηνιών

· Εισαγωγή κειμένου

· Με επιλογή από drop – down λίστες.

Note tab
Η δημιουργία σημειώσεων περιλαμβάνει:

Note tab: Την εισαγωγή κειμένου 
Category: την επιλογή κατηγορίας σημείωσης

Για την προσθήκη νέας κατηγορίας πρέπει να πάτε στο μενού Tools→ Options διαλέγετε το Tab Locations και προσδιορίζετε που θα αποθηκευτούν τα αρχεία Global.

Add: Γίνεται προσθήκη της σημείωσης.
Ενέργειες και διάρκεια 

Για την προσθήκη μιας ενέργειας σε ένα έργο ακολουθούμε τα εξής βήματα:

· Κλικ σε μια γραμμή ενεργειών.
· Συμπλήρωση αρχικής – τελικής ημερομηνίας ενέργειας.

· Με διπλό κλικ στη επικεφαλίδα της ενέργειας  συμπληρώνουμε και τα υπόλοιπα στοιχεία μιας ενέργειας της.

General tab
Name:όνομα ενέργειας 
Category:κατηγορία στην οποία ανήκει η ενέργεια, αν υπάρχει.
ID: κωδικός ενέργειας 

Type: ορισμός φάσης, δραστηριότητας, ενέργειας, οροσήμου.
Key Task check box: επιλογή μιας ενέργειας ως βασικής.

Duration text box: διάρκεια ενέργειας 

Fixed check box: αν δεν θέλουμε να αλλάξει η διάρκεια μιας φάσης κατά την επιλογή autoschedule τσεκάρουμε αυτή την επιλογή.

Priority: επιλογή προτεραιότητας ενέργειας, ορίζεται με τον ίδιο τρόπο όπως του έργου.
Ημερομηνιές: Στην συνέχεια ακολουθεί μια σειρά από ημερομηνίες από τις οποίες ο χρήστης μπορεί να αλλάξει μόνο την current. Η baseline δημιουργείται αυτόματα Tools→ Baselines→ Set Baselines και χρησιμοποιείται ως σύγκριση μεταξύ των εκτιμήσεων ή των εκτιμήσεων και των πραγματικών τιμών. Η early και η late δημιουργούνται αυτόματα όταν επιλέγουμε την εύρεση του CPM ή την εντολή autoschedule.
% Complete: καταγραφή του ποσοστού ολοκλήρωσης μιας ενέργειας.
Resources Tab
Αρχικά διαλέγουμε ένα πόρο και με το assign τον αναθέτουμε σε μια ενέργεια. Άλλες πληροφορίες που μπορούμε να προσθέσουμε είναι:

	Estimate
	Ο εκτιμώμενος χρόνος που πρέπει να δεσμευτεί ένας πόρος για να ολοκληρωθεί η ενέργεια.

	Actual
	Η συνολικός πραγματικός χρόνος που αφιέρωσε ένας πόρος σε μια ενέργεια.

	Loading
	Ο τρόπος με τον οποίο κατανέμεται ο χρόνος μπορεί να είναι στην αρχή μιας ενέργειας, στο τέλος μιας ενέργεια, ομοιόμορφα σε όλη τη διάρκεια μιας ενέργεια, ανάλογα με τις επικαλύψεις των διαφόρων ενεργειών στους πόρους, η προκαθορισμένα ανά χρονική περίοδο.

	Baseline
	δέχεται δεδομένα baseline και αυτόματα υπολογίζει μια τιμή που προέρχεται από εκτιμήσεις και πραγματικές τιμές. 

	Max %
	Ποσοστό διαθεσιμότητας πόρου.

	Act Through
	Η τελευταία ημερομηνία που καταγράφηκε τιμή Actual


Dependencies tab
Για την δημιουργία εξαρτήσεων επιλέγουμε μια ενέργεια από το μενού ενεργειών  που εμφανίζεται στο κάτω μέρος και επιλέγουμε αν μια ενέργεια θα είναι predecessor (η ενέργεια θα προηγείται της ενέργειας στην οποία βρισκόμαστε) ή successor (η ενέργεια θα έπεται της ενέργειας στην οποία βρισκόμαστε)
	Field
	Description

	Type
	Start-Finish
Η ενέργεια που έπεται δεν μπορεί να τελειώσει πριν ξεκινήσει η ενέργεια που προηγείται. 
Finish-Finish
Η ενέργεια που έπεται δεν μπορεί να τελειώσει πριν τελειώσει η ενέργεια που προηγείται..
Start-Start
Η ενέργεια που έπεται δεν μπορεί να αρχίσει πριν αρχίσει η ενέργεια που προηγείται.
Finish-Start
Η ενέργεια που έπεται δεν μπορεί να αρχίσει πριν τελειώσει η ενέργεια που προηγείται.


	Lag
	Μέρες ή ποσοστό που δείχνει το κενό ή την επικάλυψη ανάμεσα στις ενέργειες.

Enter a number that represents days or a percent to indicate the amount of time between, or overlapping, task start or finish dates. Use of the task start or finish date is determined by the dependency type selected in the Type column. For more information, see “Understanding lag” on page 158.

	Lag Type
	 Ο τύπος του Lag:  μέρες, ή ποσοστό %

Choose Daily or Percent from the drop-down list. Your selection corresponds to the value entered in the Lag text box.
Finish-Finish τύπος εξάρτησης:% διάρκειας ενέργειας που έπεται.

σε όλους τους άλλους τύπους είναι το ποσοστό της διάρκειας της διάρκειας της ενέργειας που προηγείται.


Καθορισμός πόρων ενός έργου
Για τον καθορισμό των πόρων ενός έργου διπλό κλίκ στην επικεφαλίδα των πόρων και συμπληρώνεται το General Tab:

 General tab
 Name, είσοδος ονόματος πόρου.

 Category, κατηγοριοποίηση πόρων σε κατηγορίες που ορίζει ο χρήστης.

 ID, μοναδικός κωδικός πόρου.

 Rate, η μονάδα με βάση της οποίας χρεώνεται ένας πόρος. Μπορεί να είναι κάποιες ώρες ή μέρες .enter the r

 Type: υπάρχουν 4 είδη πόρων Labor(υπάλληλοι), Expense(χρήματα), Materials (υλικά), and Equipment(εξοπλισμός).)

 Availability, διαθεσιμότητα πόρου μπορεί να είναι ώρες/ημέρα,ημέρες εβδομάδα,  ή ποσοστό ημέρας. 

 From, η πρώτη ημερομηνία που είναι διαθέσιμος ο πόρος.
 To, η τελευταία ημερομηνία που είναι διαθέσιμος ο πόρος.
Διάγραμμα Gantt
Το διάγραμμα Gantt είναι ένα εργαλείο χρονοπρογραμματισμού το οποίο στον οριζόντιο άξονα απεικονίζει μια κλίμακα χρόνου και στον κατακόρυφο απεικονίζει τις ενέργειες που προκύπτουν από την μέθοδο «κατακερματισμού εργασίας». To διάγραμμα Gantt υποστηρίζει τη γραφική απεικόνιση των φάσεων, ενεργειών, ορόσημων ενός έργου με τη μορφή ράβδων σε μια κλίμακα χρόνου. Η οριζόντια μπάρα απεικονίζει την διάρκεια μιας ενέργειας ενώ οι κατακόρυφες την ημερομηνία έναρξης και λήξης ενός έργου.  Συνοψίζοντας τις ιδιότητες ενός διαγράμματος Gantt:

· Επιτρέπει την απεικόνιση της διάρκειας μιας ενέργειας.

· Επιτρέπει την απεικόνιση της σειράς με την οποία πραγματοποιούνται οι ενέργειες.

· Επιτρέπει την διαχείριση των εξαρτήσεων ανάμεσα στις ενέργειες 

· Υποστηρίζει την παρακολούθηση της εξέλιξης των ενεργειών σε ένα χρονικό σημείο.

· Υποστηρίζει την διεξαγωγή διορθωτικών κινήσεων και την απεικόνιση των αποτελεσμάτων τους.

Στο Workbench το διάγραμμα δημιουργία απευθείας με την προσθήκη των ενεργειών και του καθορισμού των ημερομηνιών έναρξης και λήξης τους. Μέσα στο διάγραμμα Gantt του Workbench μπορείτε χειρονακτικά να αλλάξετε τις ημερομηνίες των ενεργειών μετακινώντας τις ράβδους και επίσης να ορίσετε τις εξαρτήσεις μεταξύ των ενεργειών.

Δημιουργία και τροποποίηση διαγράμματος Gantt.

Οι διάφορες ιδιότητες του διαγράμματος Gantt μπορούν να αλλάξουν με διπλό κλικ στο διάγραμμα:

	% Displayed Option
	Περιγραφή 

	Pct Expend
	Προβολή % της εργασίας που πραγματοποιήθηκε για μια ενέργεια προς την εκτιμώμενη τιμή της εργασίας. 

	Pct Complete
	Προβολή % της εργασίας που ολοκληρώθηκε μέχρι την τρέχουσα ημερομηνία.

	Act Thru
	% πραγματικής εργασίας προς την εκτιμώμενη μέχρι την τρέχουσα ημερομηνία.

	No Pct
	Δεν γίνεται προβολή κάποιου ποσοστού.


Ακολουθεί μια σειρά από check boxes:
	Baseline
	Εμφανίζει στο διάγραμμα Gantt τα δεδομένα baseline σε σύγκριση με τα πραγματικά δεδομένα. Ένα Baseline είναι μια αρχική εκτίμηση που έγινε για την διάρκεια των ενεργειών η οποία μπορεί να αλλάξει στη συνέχεια. Τα baseline μπορούν να χρησιμοποιηθούν για να γίνει έλεγχος της εξέλιξης του έργου σε σχέση με τις αρχικές εκτιμήσης.

Για να θέσουμε κάποιες ημερομηνίες που έχουμε εισάγει ως baseline πάμε Tools→ Baselines→ Set Baselines

	Discontinuous
	Εμφανίζει μπάρες οι οποίες εμφανίζουν τα διαλείμματα όπως γιορτές και Σαββατοκύριακα. 

	Float
	Εμφανίζει μπάρες οι οποίες δείχνουν την αργότερη ημερομηνία την οποία μπορεί να τελείωσει ένα έργο.

	Stacked
	Τονίζει τα δεδομένα baseline.

Πρέπει να έχει επιλεχθεί η εμφάνιση δεδομένων baseline.

	Show Dependencies
	Εμφανίζει τις εξαρτήσεις ανάμεσα στις ενέργειες. Επιτρέπει την δημιουργία εξαρτήσεων ανάμεσα στις ενέργειες.

	Freeze Gantt Bars
	Απαγορεύει την τροποποίηση του διαγράμματος χειρονακτικά.


Για να αλλάξουμε την κλίμακα χρόνου στο διάγραμμα Gantt επιλέγουμε το Time Scale και καθορίζουμε αν κλίμακα θα είναι μέρες, βδομάδες η μήνες καθώς και την αρχική ημερομηνία η οποία θα απεικονίζεται στο διάγραμμα.
Αφού καθοριστούν όλες οι εξρτήσεις ανάμεσα στις ενέργειες και κατανεμηθούν οι πόροι επιλέγουμε Tools→ Critical Path για τη δημιουργία του κρίσιμου μονοπατιού. Έτσι στην όψη CPM βλέπουμε με κόκκινο περίγραμμα τις ενέργειες που βρίσκονται στο κρίσιμο μονοπάτι. Όσες ενέργειες είναι τονισμένες με κόκκινο και στο εσωτερικό τους τότε έχει γίνει λάθος στη δημιουργία του χρονοδιαγράμματος και θα πρέπει να κάνουμε διορθώσεις. Κάποιες διορθώσεις μπορεί να κάνει η επιλογή Τοοls → Autoschedule. Αν επανέλθουμε στις ιδιότητες μιας ενέργειας τότε θα δούμε τα πεδία ημερομηνιών Early και Late συμπληρωμένα.






